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[bookmark: _Toc75938720][bookmark: _Toc396387019][bookmark: _Toc534108046][bookmark: _Toc513360261][bookmark: _Ref513177801][bookmark: _Ref508254386][bookmark: _Toc502848047][bookmark: _Toc125360421][bookmark: _Hlk101193097]Introduktion til zzzPAT
Bemærk: I hele dokumentet er referencerne WatchPAT gældende for alle 4 enheder (WP200, WP200U, WatchPAT™ 300 og WatchPAT™ ONE), medmindre andet oplyses.

Den udvidede og illustrerede vejledning kan findes på Itamar-Medicals websted ( https://www.itamar-medical.com/support/downloads/  )

[bookmark: _Toc500760470][bookmark: _Toc75938721][bookmark: _Toc396387020][bookmark: _Toc203489306][bookmark: _Toc125360422][bookmark: _Toc502848050][bookmark: _Toc502848048][bookmark: _Toc513360263][bookmark: _Toc534108048][bookmark: _Toc5874853][bookmark: _Toc9050222]Tilsigtet brug/indikationer for brug af Watch-PAT200
Den integrerede snorke- og kropssensor er et tilbehør til WatchPAT™-enheden til privat brug hos patienter, som formodes at have søvnrelaterede vejrtrækningsforstyrrelser. Wp200-enheden anvendes som diagnostisk hjælp til detektering af søvnrelaterede vejrtrækningsproblemer og søvnstadier (Rapid Eye Movement (REM), let søvn og dyb søvn). Enheden genererer en perifer arteriel tonometri (”PAT”) Respiratory Disturbance Index (”PRDI”), Apnø-Hypopnø-indeks (”PAHI”), Central Apnø-Hypopnø-indeks (”PAHIc”), Pat-søvnstartsidentifikation (PSTAGES) og valgfrit snorkeniveau og kropsposition adskilt fra ekstern integreret snorke- og kropssensor (SBP). Enhedens "PSTAGES" og SBP giver supplerende information til dets PRDI/PAHI. Enhedens "PSTAGES" og SBP er ikke beregnet til at blive benyttet som det eneste eller det primære grundlag for at diagnosticere søvnrelateret vejrtrækningsforstyrrelse, ordinere behandling eller afgøre, om yderligere diagnostisk vurdering er berettiget.

WP200 er ikke indiceret til børn under 17 år.
[bookmark: _Toc75938722][bookmark: _Toc125360423]Tiltænkt brug / indikationer for brug til Watch-PAT200U , WatchPAT™ 300, og WatchPAT™ ONE
Watch-PAT200U (WP200U) , WatchPAT™ 300og WatchPAT™ ONE er enheder til ikke-invasiv, privat brug for patienter med formodet søvnrelateret vejrtrækningslidelse. WP200U, WatchPAT™ 300 og WatchPAT™ ONE er diagnostisk hjælpemiddel til konstatering af søvnrelateret vejrtrækningslidelse, snorkeniveau og kropsposition i søvnstadier (Rapid Eye Movement (REM) med søvn, let søvn, dyb søvn og vågen tilstand. Enheden genererer en perifer arteriel tonometri (”PAT”) Respiratory Disturbance Index (”PRDI”), Apnø-Hypopnø-indeks (”PAHI”), Central Apnø-Hypopnø-indeks (”PAHIc”), Pat-søvnstartsidentifikation (PSTAGES) og valgfrit snorkeniveau og kropsposition adskilt fra ekstern integreret snorke- og kropssensor (SBP). Enhedens PSTAGES, snorkeniveau og kropsstilling giver supplerende oplysninger til dets PRDI/PAHI/PAHIc. Enhedens PSTAGES og snorkeniveau og kropsstilling er ikke beregnet til at blive benyttet som eneste eller primære grundlag for diagnosticering af søvnrelaterede vejrtrækningsforstyrrelser, ordinering af behandling eller bestemmelse af, om yderligere diagnostisk vurdering er berettiget.

PAHIc er indiceret til brug hos patienter, der er 17 år eller ældre. Alle andre parametre er angivet for 12 år og ældre.

Bemærk: Denne præsentation af pAHIc er underlagt myndighedsgodkendelse i landet
[bookmark: _Toc75938724][bookmark: _Toc396387021][bookmark: _Toc203489307][bookmark: _Toc125360424]zzzPAT S/W – Definition 
zzzPAT er analysesoftware, der benyttes sammen med WP-enhederne til at hjælpe med diagnosticering af søvnrelaterede vejrtrækningsforstyrrelser, detekterer REM, let søvn, dyb søvn og vågne stadier og måler snorkeniveauet og kropspositionen. zzzPAT S/W viser de registrerede signaler fra WP-enhederne, identificerer automatisk vejrtrækningsforstyrrelser, søvnstadier indsamler data om snorken og kropsposition og genererer en omfattende rapport til lægen.
[bookmark: _Toc75938725][bookmark: _Toc396387022][bookmark: _Toc203489308][bookmark: _Toc125360425]Oversigt

zzzPAT-Algoritmer benytter de fire WP-kanaler: PAT, Pulsate, Aktigrafi og iltmætning (enten optaget i WP200 eller afledt fra WP200U/WP300/WP1) til påvisning af søvnrelaterede vejrtrækningsforstyrrelser og inddeling af søvnstadier (Rapid Eye Movement (REM), let søvn, dyb søvn og vågen tilstand). I WP200U, WatchPAT™ 300 and WatchPAT™ ONE, ved brug af RESBPs kanal for åndedrætsbevægelse sammen med WP-kanaler, gives der mulighed for yderligere identifikation af central apnø. 
ZzzPAT bruger WP's snorke- og kropspositionskanaler til at generere adskilte tilstande for snorken og kropsposition. Softwaren udsteder omfattende rapporter om undersøgelsen med statistik og grafisk præsentation af resultaterne. Hele nattens data kan ses, og de automatisk detekterede hændelser kan revideres manuelt.

Bemærk: I dette dokument refererer snorke- og kropssensor til både SBP-sensor og RESBP-sensor medmindre andet er angivet. I WP200(U)/ WatchPAT™ 300, brugen af Snorke- og kropssensor er valgfri og efter lægens skøn. Brugen af RESBP-sensoren er underlagt myndighedsgodkendelse i dit land.

Denne manual giver de nødvendige oplysninger til rutinemæssig brug af zzzPAT-softwaren.

Restriktioner
Optagelser og beregninger fra WP-systemerne er tænkt som en hjælp til diagnosticering af søvnrelaterede åndedrætsforstyrrelser. De må udtrykkeligt ikke betragtes som det eneste ubestridelige grundlag for klinisk diagnose.
zzzPAT-software bør kun bruges på kompatible computere, der opfylder kravene specificeret i dette dokument.
At køre andre programmer, kommercielle eller tilpassede, samtidigt med zzzPAT kan forstyrre den korrekte funktion.
Søvn/dvale-funktioner bør deaktiveres i tilfælde af delt databasekonfiguration.


[bookmark: _Toc75938726][bookmark: _Toc396387023][bookmark: _Toc125360426]Installation
[bookmark: _Toc75938727][bookmark: _Toc396387024][bookmark: _Toc534108050][bookmark: _Toc513360265][bookmark: _Toc125360427]Overordnet beskrivelse af zzzPAT-software
zzzPAT er en proprietær PC-software udviklet specifikt til styring og analyse af data optaget med WP-enheden. Softwaren viser og gemmer signalerne og giver et sæt analytiske funktioner til fortolkningsformål.

WP200(U)/ WatchPAT™ 300 et USB-kabel benyttes til at læse de data, der er optaget af WP på det interne hukommelseskort. ZzzPAT S/W detekterer automatisk dataene på det interne hukommelseskort, når WP'en er tilsluttet PC'en via USB-kommunikationskablet.
I WatchPAT™ ONE, benyttes en internetforbindelse til at læse data, der er optaget med WatchPAT™ ONE. ZzzPAT S/W åbner automatisk en liste med alle registrerede patienter, som studier endnu ikke er hentet ned fra webserveren.
Se venligst afsnit 0 for påkrævet PC-konfiguration.

zzzPAT har to funktioner:

Standalone - til brug på én PC med en lokal database.
Delt adgang - til brug i et netværksmiljø, hvor flere zzzPAT-stationer får adgang til én enkelt, delt database. 

	[image: clip_image002]
	Bemærk

	
	Det anbefales stærkt at koordinere indstillingerne for delt adgang zzzPAT- driftstilstand med en Itamar Medical-repræsentant. Ekstra træning er afgørende for korrekt drift.
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	Advarsel

	
	WatchPAT200U-enheden kontrolleres med en PC. Det anbefales at installere antivirussoftware til at beskytte systemet og filerne og passende adgangskontrol.



[bookmark: _Toc534108124][bookmark: _Ref30906401][bookmark: _Toc396387025][bookmark: _Toc513360266][bookmark: _Toc534108051]zzzPAT-driftsformen bestemmes under installationen som yderligere beskrevet i afsnittet Installation af den udvidede og illustrerede vejledning
[bookmark: _Toc448932632][bookmark: _Toc448932636][bookmark: _Toc448932639][bookmark: _Toc448932640][bookmark: _Toc448932642][bookmark: _Toc396386972][bookmark: _Toc396387028][bookmark: _Toc396386973][bookmark: _Toc396387029][bookmark: _Toc448932647][bookmark: _Toc448932648][bookmark: _Toc448932649][bookmark: _Using_zzzPAT_Software][bookmark: _Toc502848056][bookmark: _Ref508259397][bookmark: _Ref508259407][bookmark: _Ref508536776][bookmark: _Ref508536782][bookmark: _Toc513360268]
[bookmark: _Ref530980953][bookmark: _Toc534108054]
[bookmark: _Toc75938728][bookmark: _Toc396387035][bookmark: _Toc125360428][bookmark: _Ref29868162]Opsætning af zzzPAT-konfiguration
[bookmark: _Toc448932658][bookmark: _Toc448932657][bookmark: _Toc448932656][bookmark: _Toc448932655][bookmark: _Toc75938729][bookmark: _Toc396387037][bookmark: _Toc534108100][bookmark: _Toc513360303][bookmark: _Toc125360429]Opsætning> Biblioteker
Viser zzzPAT-arbejdsbiblioteket, navnet på den aktuelt tilsluttede database, filbiblioteket (signaldatafiler) og USB-drevet. 

Vælg “DB Logged Users” for at se, hvem som er forbundet til den delte database. 
Listen vil indeholde alle de computernavne, der bruger den samme, delte database og har zzzPAT-applikationen kørende.
[bookmark: _Toc125360430][bookmark: _Toc75938730][bookmark: _Toc396387038][bookmark: _Toc534108101][bookmark: _Toc513360300][bookmark: _Toc502848061]Opsætning>Brugerindstillinger  
Brugeren kan ændre følgende parametre til opsætning ved at åbne ‘Brugerindstillinger’ dialogboksen i Opsætning>Brugerindstillinger. Opsætningsparametrene for ‘Brugerindstillinger’ gemmes i zzzPAT-databasen for hver bruger (enten den lokale database for en selvstændig installation eller den delte adgangsdatabase, der findes i en delt adgangsinstallation).

	[image: clip_image002]
	Bemærk

	
	Når en bruger i en delt adgangstilstand logger på fra flere zzzPAT-stationer samtidigt, vil ændringer af nogle af de konfigurerbare indstillinger for zzzPAT muligvis ikke blive gemt, efter zzzPAT-sessionen slutter




[bookmark: _Toc534108102][bookmark: _Toc513360302]Når alle indstillingsændringer er fuldført klikkes OK for at lukke dialogboksen.

Se udvidet og illustreret vejledning for detaljeret beskrivelse
[bookmark: _Toc23069019][bookmark: _Toc23069018][bookmark: _Toc23069017][bookmark: _Toc23069016][bookmark: _Toc23069015][bookmark: _Toc23069014][bookmark: _Toc23069013][bookmark: _Toc23069012][bookmark: _Toc23069011][bookmark: _Toc23069010][bookmark: _Toc23069009][bookmark: _Toc23069008][bookmark: _Toc23069007][bookmark: _Toc23069006][bookmark: _Toc23069005][bookmark: _Toc23069004][bookmark: _Toc23069003][bookmark: _Toc23069002][bookmark: _Toc23069001][bookmark: _Toc23069000][bookmark: _Setup>User_Settings>Options][bookmark: _Toc23068999][bookmark: _Toc23068998][bookmark: _Toc23068997][bookmark: _Toc23068996][bookmark: _Toc23068995][bookmark: _Toc23068994][bookmark: _Toc23068993][bookmark: _Toc23068992][bookmark: _Toc23068991][bookmark: _Toc23068990][bookmark: _Toc23068989][bookmark: _Toc23068988][bookmark: _Toc23068987][bookmark: _Toc23068986][bookmark: _Toc23068985][bookmark: _Toc23068984][bookmark: _Toc23068983][bookmark: _Toc23068982][bookmark: _Toc23068981][bookmark: _Toc23068980][bookmark: _Toc23068979][bookmark: _Toc23068978][bookmark: _Toc23068977][bookmark: _Toc23068976][bookmark: _Toc23068975][bookmark: _Toc75938731][bookmark: _Toc396387039][bookmark: _Toc125360431][bookmark: _Ref5871947][bookmark: _Toc534108104][bookmark: _Toc513360304]Opsætning>Generelle Indstillinger
Kun en bruger med 'Brugeradministration'-tilladelse kan ændre de følgende opsætningsparametre ved at åbne dialogboksen 'Generelle Indstillinger' fra Opsætning>Generelle indstillinger. 'Generelle Indstillinger' gemmes i zzzPAT-databasen (enten den lokale database i en selvstændig installation eller den delte adgangsdatabase i en installation med delt adgang).

Disse indstillinger er globale. Modificerede indstillinger bliver tilgængelige til alle brugere.

[bookmark: _Toc396387102]Når alle indstillingsændringer er fuldført, klikkes der på OK for at lukke  dialogboksen. 

Se udvidet og illustreret vejledning for detaljeret beskrivelse

[bookmark: _Toc23069086][bookmark: _Toc23069085][bookmark: _Toc23069084][bookmark: _Toc23069083][bookmark: _Toc23069082][bookmark: _Toc23069081][bookmark: _Toc23069080][bookmark: _Toc23069079][bookmark: _Toc23069078][bookmark: _Toc23069077][bookmark: _Toc23069076][bookmark: _Toc23069075][bookmark: _Toc23069074][bookmark: _Toc23069073][bookmark: _Toc23069072][bookmark: _Toc23069071][bookmark: _Toc23069070][bookmark: _Toc23069069][bookmark: _Toc23069068][bookmark: _Toc23069067][bookmark: _Toc23069066][bookmark: _Toc23069065][bookmark: _Toc23069064][bookmark: _Toc23069063][bookmark: _Toc23069062][bookmark: _Toc23069061][bookmark: _Toc23069060][bookmark: _Toc23069059][bookmark: _Toc23069058][bookmark: _Toc23069057][bookmark: _Setup>General_Settings>Analysis/Sta][bookmark: _Toc23069056][bookmark: _Toc23069055][bookmark: _Toc23069054][bookmark: _Toc23069053][bookmark: _Toc23069052][bookmark: _Toc23069051][bookmark: _Toc23069050][bookmark: _Toc23069049][bookmark: _Toc23069048][bookmark: _Toc23069047][bookmark: _Toc23069046][bookmark: _Toc23069045][bookmark: _Toc23069044][bookmark: _Toc23069043][bookmark: _Toc23069042][bookmark: _Toc23069041][bookmark: _Toc23069040][bookmark: _Toc23069039][bookmark: _Toc23069038][bookmark: _Toc23069037][bookmark: _Toc23069036][bookmark: _Toc23069035][bookmark: _Toc23069034][bookmark: _Toc23069033][bookmark: _Toc23069032][bookmark: _Toc23069031][bookmark: _Toc23069030][bookmark: _Toc23069029][bookmark: _Toc23069028][bookmark: _Toc23069027][bookmark: _Toc23069026][bookmark: _Toc23069025][bookmark: _Toc23069024][bookmark: _Toc23069023][bookmark: _Toc23069022][bookmark: _Toc23069021][bookmark: _Toc75938732][bookmark: _Toc396387040][bookmark: _Toc125360432]Brug af zzzPAT
[bookmark: _Toc75938733][bookmark: _Ref449876863][bookmark: _Toc396387041][bookmark: _Toc125360433]Forberedelse af nyt studie
Forberedelse af patientfilen er et obligatorisk trin i forberedelsen af WP enheder til et søvnstudie. 

Start af zzzPAT
Start ‘zzzPAT’ ved at klikke på zzzPAT ikonet [image: ] på dit skrivebord.
Hvis zzzPAT-ikonet [image: ] åbnes, åbnes dialogboksen til log ind herefter:

Indtast log ind og kodeord. Når en delt adgangstilstand er installeret, giver log ind skærmen brugeren mulighed for at vælge, hvilken database zzzPAT skal oprette forbindelse til. 
Log ind dialogboksen har to muligheder for login: 
· Aktivt bibliotek (nuværende domæneserver). 
· Brugere fra zzzPAT-databasen 

Hvis det er relevant, vælges den ønskede database for at oprette forbindelse dertil.
Indtast dit log ind navn og kodeord og klik OK for at fortsætte.

[bookmark: _Ref244001441]Forberedelse af nyt studie

Vinduet ved navn Ny Undersøgelse vil blive åbnet med felter i henhold til standard enhedstype (WP200(U)/ WatchPAT™ 300/ WatchPAT™ ONE) i henhold til konfigurationen.

Forberedelse af nyt studie (WP200(U)/ WatchPAT™ 300)

Sørg for, at enheden er forbundet til PC'en med zzzPAT-softwaren ved brug af USB-kablet.
Klik Fil>Nye Studiedetaljer i zzzPAT, eller klik ‘Nyt Studie’-ikonet [image: ] i værktøjslinjen.
Dialogboksen for "Nyt Studie" fremkommer.
Udfyld de obligatoriske Patient ID detaljer i Patient felterne. 
Indsæt eventuelle yderligere oplysninger, hvis det er nødvendigt, resten af felterne er valgfrie.
Vælg "Pacemaker", hvis patienten har en pacemaker. ZzzPAT'en vil automatisk detektere segmenter, hvor PAT-impulserne synes at være pacet dvs. meget lave variationer i pulsfrekvens (nærmest stabile) og udelukke disse segmenter fra analysen.

	[image: clip_image002]
	Bemærk

	
	Nogle typer af pacemakere udelukker brugen af WatchPAT-enheden. Se udelukkelseskriterier afsnittet i enhedens betjeningsvejledning for flere detaljer.




Vælg "Undersøg med indgrebssikker test", hvis du ønsker at benytte identifikationsarmbåndet. Ved at aktivere denne mulighed kan du benytte armbåndet til at bekræfte, at den identificerede patient faktisk er den, der sover med enheden (se manipulationssikker test i WP brugervejledning).
Vælg "Flere nætter" for at køre op til 3 nætter med den samme WP-enhed
WatchPAT™ 300: Indstillingen "Kør enhedstest" vises kun, når en enhed er tilsluttet. Ved at vælge denne mulighed vil den tilsluttede enhed blive testet, og resultaterne vises i et separat vindue. Denne test vil udføre den samme "Test Enhed" funktion, der køres fra en selvstændig enhed (se Operatørtest i WP brugervejledning).
WatchPAT™ 300: Indstillingen "Kør enhedstest, mens du gemmer..." vises kun, når en enhed er tilsluttet. Ved at vælge denne mulighed testes den tilsluttede enhed automatisk, når brugeren vælger 'Gem til WatchPAT', og resultaterne vises i et separat vindue. Denne test udfører den samme "Test Enhed", der køres fra en selvstændig enhed.
For at registrere et studie til WatchPAT™ ONE-enheden skal du bruge knappen "Skift til WP-ONE-enhed"
Klik på knappen Gem til WatchPAT .
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	Bemærk

	
	De enheder, der bruges til vægt og højde i dialogboksen 'Nyt Studie', er defineret ud fra de regionale indstillinger på PC'en.



Hvis WP deholder data (enten et studie om natten, der ikke er blevet indlæst i zzzPAT-databasen eller nye patientdata, som er blevet klargjort, men ikke brugt i et studie), åbnes dialogboksen ”Data ikke indlæst”
Efter registrering af patientens informationer på webserveren, vises beskeden om, at studiet er gemt

Klik Ja - , hvis du vil forberede endnu et studie.
Klik Nej - , hvis du vil lukke ‘Nyt Studie’ dialogboksen.

Afbryd USB-kablet fra enheden.

Forberedelse af nyt studie WatchPAT™ ONE)
Sørg for, at du er en aktiv internetforbindelse 
Klik Fil>Nye Studiedetaljer i zzzPAT, eller klik ‘Nyt Studie’-ikonet [image: ] i værktøjslinjen.
Dialogboksen for "Nyt Studie" fremkommer.
Udfyld de obligatoriske felter: Patient ID, Enhed SN og PIN.
[bookmark: _Hlk527616295]Sørg for, at den e-mailadresse, der fremgår på skærmen, er korrekt for at kunne modtage e-mail-beskeder (e-mail-adresse defineres under opsætningen).
Indsæt eventuelle yderligere oplysninger, hvis det er nødvendigt, resten af felterne er valgfrie.
Vælg indstillingen "Flere nætter" for at køre op til 3 nætter med den samme WatchPAT™ ONE-M-enhed ved at oplade sonden hver nat. Denne indstilling vises kun, hvis funktionen er aktiveret i Opsætning>Generelle indstillinger>Generelle valgmuligheder. Når "Flere nætter" er markeret, vil valget af "2 nætter" eller "3 nætter" fremkomme, og den valgte standardvalgmulighed vil være i overensstemmelse med, hvad der er defineret i Generelle valgmuligheder. Yderligere obligatoriske tekstfelter vises for at definere de andre sonders SN-numre
Klik på knappen "Registrer WP-ONE" for at registrere enheden og sonderne. Registrering vil ikke lykkes i følgende tilfælde:
· Hvis et af SN-numrene er ugyldigt eller mangler. 
· Hvis et af SN-numrene allerede er registreret.
For at starte studie for WatchPAT™ 300 eller WP200(U)-enheden, benyttes knappen "Skift til WP-enhed".

	[image: clip_image002]
	Bemærk

	
	Hvis den samme WatchPAT™ ONE-enheds-SN allerede er registreret, vises en fejlbesked, som giver brugeren besked om at indtaste korrekt/andet enhed-SN.
Udfyld de korrekte informationer og tryk igen på knappen Registrer WP-ONE .



	
	

	
	De enheder, der bruges til vægt og højde i dialogboksen 'Nyt Studie', er defineret ud fra de regionale indstillinger på PC'en.




Efter registrering af patientens informationer på webserveren, vises beskeden om, at studiet er gemt:

Klik Ja - , hvis du vil forberede endnu et studie.
Klik Nej - , hvis du vil lukke ‘Nyt Studie’ dialogboksen.

Nyt studie, skærmfunktioner

Udover de felter på hovedskærmen, der kræves for at forberede et nyt studie, er der yderligere felter, som tillader grundig dokumentation af patientens tidligere og nuværende medicinske tilstand. Derudover tillader zzzPAT dig at indlæse patientdetaljer fra tidligere studier. Andre funktioner på denne skærmen tillader organisering af studier i grupper ved brug af egne kategorier.

Se udvidet og illustreret vejledning for detaljeret beskrivelse


[bookmark: _Toc513360269][bookmark: _Toc75938734][bookmark: _Toc396387042][bookmark: _Toc534108055][bookmark: _Toc125360434][bookmark: _Toc502848059]Håndtering af patient Studier
WP200(U)/ WatchPAT™ 300: Efter et WP søvnstudie er overstået, forbindes WatchPAT til en USB, hvorefter zzzPAT- applikationen åbnes, og der trykkes Fil>Indlæs Studie and analyser fra hovedmenuen. De registrerede digitale data indlæses i zzzPAT-databasen og analyseres automatisk. 
WatchPAT™ ONE: Efter et WatchPAT™ søvnstudie er overstået, åbnes zzzPAT-applikationen, og der trykkes Fil>Indlæs Studie og Analyser fra hovedmenuen. Der åbnes et vindue med alle registrerede patienter, som studiet endnu ikke har hentet fra webserveren. Vælg det studie, som skal downloades, og de registrerede data vil herefter blive indlæst i zzzPAT-databasen for den valgte patient. De registrerede data bliver automatisk analyseret. Når et studie er indlæst, kan brugeren gennemgå, redigere, tilføje diagnose og anbefalinger og producere en søvnrapport. Tidligere indlæste studier kan åbnes og blive gennemgået.


	
[image: clip_image002]
	Bemærk

	
	Listen over alle registrerede WatchPAT™ ONE-enheder indeholder kolonnen "Status" med følgende muligheder: "Klar", "Ikke startet" og "I gang". Tryk på knappen "Kontroller status" for at opdatere status for alle de registrerede enheder.



	
[image: clip_image002]
	Bemærk

	
	Det er muligt at søge efter patienter ved hjælp af patient-id'et og efter enheder, der bruger enhedens SN.




	
[image: clip_image002]
	Bemærk

	
	For at skifte mellem WatchPAT™ ONE’s registrerede patientliste og downloade studiet fra WP200(U)/ WatchPAT™ 300-enheden vælges knappen “Skift til WP200/300-enhed”.



[bookmark: _Toc534108056]Fil>Nye Studiedetaljer

Forbered patientfilen på WP til et søvnstudie (Afsnit 4.1).

[bookmark: _Toc534108057]Fil>Indlæs Studie og Analyser

Denne kommando indlæser studiedata for søvnstudiet fra enheden og gemmer dem i zzzPAT-databasen.
Mens dataene indlæses, vises meddelelsen "Indlæsning Af Studie" på skærmen, hvilket indikerer, at data overføres fra WatchPAT til harddisken, og patientfilen er gemt i databasen.
[bookmark: _Toc534108058]Under dette stadie udføres automatisk analyse, og resultaterne gemmes i databasen. Efter automatisk analyse er fuldført, vises resultaterne på skærmen. Brugeren har muligheden for at vise “Søvnrapporten”.

WP200(U)/WP300: Når et multistudie er indlæst, indlæses alle nattens studier automatisk, og sidst indlæste studie vil blive vist. Brug Åben Studie dialogboksen for at åbne og gennemgå alle nattens studier. 
	
[image: clip_image002]
	Bemærk

	
	Ved indlæsning af studiet med WatchPAT™ 300-enheden kontrolleres firmwarens version. Hvis enheden ikke har seneste firmwareversion installeret, vises følgende meddelelse:
““Der er nyere firmwareversion tilgængelig for enhedsnummer XXX. Det anbefales at bruge seneste firmwareversion.
Brug 'Hjælp'->'Besøg vores websted for at opgradere Watch-PAT-enheden' og hente opgraderingssoftware.”
Se afsnit 5.8 for mere information om at opgradere firmwareversionen.



[bookmark: _Ref5870366][bookmark: _Ref449882566]
Fil>Åbn studie 

Åbner studier gemt i zzzPAT-databasen fra de tidligere indlæste studier. Dobbeltklik på en patient, hvorefter studier for den pågældende patient vises med dato/klokkeslæt for hvert   studie. Dobbeltklik på [image: ] studieikonet for at indlæse og vise registrerede informationer på skærmen. 
Hvis der findes flere analyser for et studie, vises en dialogboks, som beder dig om at vælge den analyse, der skal åbnes.

Vælg Studie knappen
Gør det muligt for brugeren at definere, vælge og organisere de viste studier i dialogboksen 'Vælg patientstudie'.
Se udvidet og illustreret vejledning for detaljeret beskrivelse
[bookmark: _Toc534108061][bookmark: _Toc534108062]Fil>Gem Studieresultater

Gemmer de patientresultater (hændelser), som i øjeblikket vises, uden at lukke zzzPAT, gemmer studiet som gennemgået. Denne funktion er vigtig, når respiratoriske hændelser redigeres (tilføjes eller slettes), og de nye hændelser skal gemmes til brug i fremtidige zzzPAT-sessioner.

Fil>Gem som Ny Analyse

Gemmer den aktuelle analyse med de aktuelle hændelser og signaler som en ny analyse. 

Fil>Luk Studie

Lukker det patientstudie, der i øjeblikket vises, uden at lukke zzzPAT.

Fil>Luk 

Lukker både patientstudiet, der vises, og zzzPAT.

[bookmark: _Ref54576982][bookmark: _Toc534108063][bookmark: _Toc513360270][bookmark: _Ref508254354]Rediger>Studiedetaljer

Åbner dialogboksen 'Vis detaljer for studiet' med aktuelle patientoplysninger. Denne information kan redigeres ved at klikke på Rediger knappen. Autoriserede brugere kan ændre patient ID én gang.

Rediger>Fortryd 
Et valg af “Fortryd” eller klik på [image: ] zzzPAT-værktøjslinjen tillader brugeren at fortryde den seneste handling. 

Rediger>Søvnstadie ændring ved brug af musen 
Vælges det eller klikkes der [image: ] zzzPAT-værktøjslinjen, skiftes der mellem og du kan manuelt redigere søvnstadier og CSR-tider med musen. Hvis indstillingen er valgt, og musen placeres over en hændelse i søvnstadiet (dvs. let søvn), ændres musepilen til en hånd, og den valgte hændelse kan nu trækkes eller ændres i overensstemmelse hermed. 

[bookmark: _Toc448932666]Rediger>Kopier…
Når en signalsektion er fremhævet, bliver Kopier-funktionen aktiveret for at give brugeren mulighed for at kopiere de ønskede data til udklipsholderen som et billede eller til en fil i binært format.
[bookmark: _Toc75938735][bookmark: _Ref519084358][bookmark: _Toc396387043][bookmark: _Toc125360435]Skærmbilledet

Hovedskærmen viser WP registrerede bølgeformer med de hændelser, som blev detekteret af den automatiske analyse. Sporene vises synkroniseret til en ensartet tidsbase.

[bookmark: _Ref66728932]Se udvidet og illustreret vejledning for detaljeret beskrivelse
[bookmark: _The_All_Night][bookmark: _Ref6238670][bookmark: _Toc534108064][bookmark: _Toc513360271][bookmark: _Ref520722074]Vindue for hele natten og kanalvisning

Det er muligt at se enhver kanal, du vælger i et såkaldt 'Vindue for hele natten'-display, selvom du ændrer tidsbasen for visning af alle studiets kanaler.
Naviger for at få vist hele nattens vindue Se>Vindue for hele natten, marker ‘Hele natten’.
Eller Se>Kanaler .
Kryds af i boksen til venstre for ‘Synlig’ i Hele natten afsnittet.
Vælg den kanal, som du ønsker at få vist, i "Vindue for hele natten".

Se udvidet og illustreret vejledning for detaljeret beskrivelse

[bookmark: _Toc513360272][bookmark: _Toc534108065]
[bookmark: _Toc534108067][bookmark: _Toc513360275]Den aktive kanal

Hvis du klikker på en kanal eller en titel på en kanal, aktiveres denne kanal (farven på det aktiverede signal og titler ændres).


Et højreklik på en titel på en kanal aktiverer kanalen og åbner en pop op-menu 

[bookmark: _Toc513360284][bookmark: _Toc534108068]
Statusbjælke

Statusbjælken ved navn  i bunden af skærmen indeholder følgende informationer:
Database-forbindelse (Delt eller Lokal)
Realtidsur
Fremhævet starttid for segment
Fremhævet sluttid for segment
Varighed
Tidstilstand (REL/ABS)
[bookmark: _Toc75938736][bookmark: _Ref520722093][bookmark: _Toc396387044][bookmark: _Toc534108069][bookmark: _Toc513360276][bookmark: _Toc125360436]Signal Display-muligheder
[bookmark: _Ref519093479][bookmark: _Toc513360273][bookmark: _Toc534108070]Se>Definer kanaler i Montage 
Montage-skærmen består af en liste med alle signalkanaler, der er tilgængelige for visning:
PAT- PAT signal.
Pulshastighed - Afledt fra PAT-signalet.
PAT-Amplitude - PAT-signalindhylling.
SpO2 - arteriel iltmætningsniveau.
Aktigraf - Aktigrafisk signal.
WP-stadier - REM, Let Søvn, Dyb Søvn og Vågen Tilstand.
Kropsposition (ekstraudstyr)
Snorken (ekstraudstyr)
Resp.Mov (ekstraudstyr)

Se udvidet og illustreret vejledning for detaljeret beskrivelse
[bookmark: _Toc23069146][bookmark: _Toc23069145][bookmark: _Toc23069144][bookmark: _Toc23069143][bookmark: _Toc23069142][bookmark: _Toc23069141][bookmark: _Toc23069140][bookmark: _Toc23069139][bookmark: _Toc23069138][bookmark: _Toc23069137][bookmark: _Toc23069136][bookmark: _Toc23069135][bookmark: _Toc23069134][bookmark: _Toc23069133][bookmark: _Toc23069132][bookmark: _Toc23069131][bookmark: _Toc23069130][bookmark: _Toc23069129][bookmark: _Toc23069128][bookmark: _Toc23069127][bookmark: _Toc23069126][bookmark: _Toc23069125][bookmark: _Toc23069124][bookmark: _Toc23069123][bookmark: _Toc23069122][bookmark: _Toc23069121][bookmark: _Toc23069120][bookmark: _Toc23069119][bookmark: _Toc23069118][bookmark: _Toc23069117][bookmark: _Toc23069116][bookmark: _Toc23069115][bookmark: _Toc23069114][bookmark: _Toc23069113][bookmark: _Toc23069112][bookmark: _Toc23069111][bookmark: _Toc23069110][bookmark: _Toc23069109][bookmark: _Toc23069108][bookmark: _Toc23069107][bookmark: _Toc23069106][bookmark: _Toc23069105][bookmark: _Toc23069104][bookmark: _Toc23069103][bookmark: _Toc23069102][bookmark: _Toc23069101][bookmark: _Toc23069100][bookmark: _Toc23069099][bookmark: _Toc23069098][bookmark: _Toc23069097][bookmark: _Toc23069096][bookmark: _Toc23069095][bookmark: _Toc23069094][bookmark: _Toc23069093][bookmark: _Toc23069092][bookmark: _Toc75938737][bookmark: _Toc396387045][bookmark: _Toc534108081][bookmark: _Toc513360285][bookmark: _Ref508258348][bookmark: _Ref508258341][bookmark: _Ref508258251][bookmark: _Ref508258225][bookmark: _Toc125360437][bookmark: _Toc502848060]Gennemgå, Analyser og Rapporter studie
[bookmark: _Toc513360286][bookmark: _Toc534108082]Data Analyse
zzzPAT-software udfører en automatisk analyse af de WP registrerede signaler, og analysen giver en evaluering af respiratoriske hændelser under søvnen, iltmætning, pulshastighed og statistik for søvnstadier. Det giver også statistik for snorken og kropspositionen, når SBP/RESBP-sensoren benyttes.

[bookmark: _Toc534108098][bookmark: _Toc513360298]Generering af en analyse
Registrerede studiedata analyseres automatisk efter at være blevet indlæst fra enheden. Du kan også udføre automatisk dataanalyse ved at klikke på Analyser>Genindlæs studie og analyser. 
Denne funktion genindlæser de gemte studiedata og udfører den automatiske analyse. Hvis brugeren har ændret filen (tilføjet/slettet/ændret hændelser), vil disse ændringer blive slettet og vil ikke påvirke analysen.
Når dette benyttes på en fil, der tidligere er blevet analyseret og gemt med en ældre version af zzzPAT, opretter denne funktion en ny analyse ved hjælp af den aktuelle version af zzzPAT-softwaren.

REM-Analyse er en del af den automatiske analyse, der er beskrevet ovenfor. 
Under visse forhold er REM-analyse ikke i stand til endeligt at bestemme REM-perioder ud fra de registrerede signaler. 
Når dette sker, vil displayet kun inkludere søvn og vågne stadier, og i rapporten skal sektionen REM- og søvnstadier deaktiveres med angivelse af "Uafklaret REM-detektion".
Begivenhedshåndtering

Hændelser markeret ved automatisk analyse vises i de farveskraverede felter. Hvis du placerer markøren på en begivenhed, åbnes et værktøjstip med følgende information:
Begivenhedsnavn
Begivenheden er skabt af... (automatisk analyse eller bruger)
Starttid
Varighed

Se udvidet og illustreret vejledning for detaljeret beskrivelse
[bookmark: _Adding_events][bookmark: _Ref54689320][bookmark: _Toc534108092][bookmark: _Toc513360296]
[bookmark: _Toc75938738][bookmark: _Toc396387046][bookmark: _Toc125360438]Rapporter
Alle rapporter kan blive gennemgået på skærmen og printes. 
Værktøjslinjen i rapportvisningen indeholder følgende elementer:
For at printe en rapport , klikkes på Print-knappen.
For at eksportere en rapport  til et andet format, herunder pdf, rtf, HTML, osv. klikkes der på Eksport-knappen.
[bookmark: _Ref530981062][bookmark: _Toc534108093]En bruger kan se, hvor mange sider der er i en rapport og vælge, hvilke sider der skal gennemses ved brug af [image: rep3] ikonerne.

Se udvidet og illustreret vejledning for detaljeret beskrivelse

0. [bookmark: _Report>Sleep_Report][bookmark: _Ref6288001][bookmark: _Toc534108094][bookmark: _Ref434171410]Rapport>Klinisk diagnose
Denne mulighed gør det muligt at føje en diagnose og anbefalinger til skærmbilledet Søvnrapport. De oplysninger, der udfyldes på dette skærmbillede, vises på den første side i søvnrapporten. 
· Underskriv rapporten ved at indtaste dit navn eller vælge det fra navnemenulinjen.
· Afkryds muligheden "Indstil som rapporteret" for at vise, at den aktuelle undersøgelsesanalyse er endelig, og at søvnrapporten er en endelig rapport for denne analyse.
· Afkryds muligheden "Ingen central AHI-statistik" for at udelade central apnøstatistik i rapporten.
· Afkryds muligheden "Send til HL7”, hvis HL7-tjenesten er installeret og aktiveret, for at sende den specifikke undersøgelse til HL7. Bemærk, at afkrydsningsfeltet skal markeres for hver undersøgelse, der skal sendes til HL7.

Rapport>Søvnrapport
Søvnrapporten genererer en rapport på en, to, fire eller fem sider, der giver et resumé af forsøgspersonens søvnundersøgelse i henhold til indstillingerne 
Den første side af rapporten indeholder patientoplysninger, oplysninger om søvnstudie, den henvisende læge, sygehistorie, diagnose samt anbefalinger. 

Den anden side præsenterer studieresultater, herunder Opsummering af søvnen, PAT Respiratorisk forstyrrelsesindeks (pRDI), PAT Apnø Hypopnø Indeks (pAHI), PAT Central Apnø Hypopnø Indeks (pAHIc)*, Antal begivenheder, Procentdel af den samlede søvntid med Cheyne-Stokes Respiration (%CSR)*, Statistik for mætningsniveau for ilt herunder Desatureringsindeks for ilt (ODI), gennemsnit, maksimum- og minimumsniveauer for iltmætning, Iltmætningsanalyse, pulsfrekvensstatistik, REM-søvnanalyse og AHI-sværhedsgraf.

Den tredje side viser grafiske visninger af begivenheder, snorken og positionsdiagrammet (hvis der er brugt snorke-/kropssensor), iltmætning, pulshastighed, PAT-amplitude, Vågen/Let Søvn/Dyb Søvn og REM-stadier. 

Den fjerde side præsenterer cirkeldiagrammer over søvn-/vågne tilstande samt søvnstadier, søvnforsinkelse, REM-forsinkelser, antal vågne begivenheder og søvneffektivitet samt statistik over snorke- og kropsposition (hvis der er brugt en snorke-/kropssensor).

Den femte side af søvnrapporten (valgfri)) er en valgfri side, der ikke udskrives som standard. For at få denne side udskrevet skal du først vælge muligheden "Siden Oximetri og pulsfrekvenshistogram i søvnrapporten" i Generelle indstillinger (se afsnittet 3.3.7). Følgende oximetri- og pulshistogrammer vises på denne side
· Fordeling af iltmætning: Antal sekunder for hver iltmætningsværdi
· Antal desaturationshændelser for hvert toppunkt for iltmætningsresaturation 
· Antal desaturationshændelser for hver desaturationsdybde
· Antal desaturationshændelser for hvert minimumspunkt ved desaturationshændelse (nadir)
· Pulsfordeling: Antal sekunder for hver pulsværdi

Hvis der ikke er nogen gyldig søvntid, vil histogrammerne være tomme.


*pAHIc og %CSR data gives i tilfælde af, at en RESBP-sensor blev benyttet. Præsentation af pAHIc og %CSR er underlagt myndighedsgodkendelse i landet.


Definitioner:

Søvntid: Total tid i timer, hvor patienten sover. 

PAT Respiratorisk forstyrrelsesindeks (pRDI): det estimerede antal respiratoriske begivenheder divideret med den gyldige søvntid. Angives i Respiratoriske Begivenheder/Time. Indekset beregnes under "Hele Natten", REM og Ikke-REM søvntid.

PAT Apnø Hypopnø Indeks (pAHI): det estimerede antal begivenheder med apnø- og hypopnø divideret med den gyldige søvntid. Gives i enheden Apnø og Hypopnø Begivenheder/Time. Indekset beregnes under "Hele Natten", REM og Ikke-REM søvntid.

PAT Central Apnø Hypopnø Indeks (pAHIc): det estimerede antal begivenheder med central apnø- og hypopnø divideret med den gyldige søvntid*. Gives i enheden Central Apnø og Hypopnø Begivenheder/Time.

Procentdel af den samlede søvntid med Cheyne-Stokes Respiration (%CSR): den estimerede procentdelen af CSR-mønsteret ud fra den gyldige søvntid*.

*gyldig søvntid i pAHIc og %CSR kan være forskellig fra den gyldige søvntid, der benyttes i beregningen af andre indekser, da RESBP-sensoren også skal være gyldig til denne beregning.

Desaturations indeks for ilt (ODI): antallet af begivenheder med desaturation (Standardværdi på 3% eller 4% minimums desaturation) divideret med den gyldige søvntid. Angives i Desaturationsbegivenheder/Time. Indekset beregnes under "Hele Natten", REM og Ikke-REM søvntid.

REM % af søvntiden: REM-søvnstadier som en procentdel af den totale søvntid.

Snorkeniveau i enheden dB: Da snorken kan være et tegn på søvnapnø, giver zzzPAT statistik for snorken. Grænseværdien fastlægges ifølge DB.  Snorken beregnes som procentdelen af søvntid over den angivne DB-grænseværdi.  Lydstyrken for snorken vises grafisk (40 – 70 dB).

Kropsposition: Fem kropspositioner vises grafisk (liggende, højre, venstre, bøjet og siddende). Da hyppigheden af begivenheder med apnø under søvn afhænger af patientens stilling og søvnstadiet, og derfor giver zzzPAT information om varigheden af søvnen for hver stilling – liggende, bøjet, venstre, højre og siddende. Den tilsvarende procentdel af tid brugt i hver søvnposition vises i en graf. Desuden er alle registrerede begivenheder såsom respiratorisk forstyrrelsesindeks (pRDI), apnø/hyperpnø-indeks (pAHI) og desaturationsindeks (ODI) også angivet i rapporten for hver kropsposition såvel som i den ikke-liggende stilling.

AHI-sværhedsgraf: Indikerer sværhedsgraden af obstruktiv søvnapnø (OSA). Ifølge American Academy of Sleep Medicine (AASM) er det kategoriseret i mild (5-15 begivenheder/time), moderat (15-30 begivenheder/time) og svær (>30 begivenheder/time). Sværhedsgraden for de givne kategorier kan ændres, se Opsætning>Generelle indstillinger>Analyse/Statistik-parametre.
[bookmark: _Toc396387142]
[bookmark: _Toc534108095]Rapport>søvnrapport for det valgte tidsinterval

Denne mulighed genererer en rapport på to sider, der giver en oversigt over forsøgspersonens søvnstudie i en given tidsperiode der er valgt af brugeren.

For at generere en rapport for en given tidsperiode:
· Fremhæv den ønskede sektion af bølgeformen i visningsvinduet for signalet ved at klikke og trække med musen.
· Klik Rapport> søvnrapport for valgt tidsperiode.

Se udvidet og illustreret vejledning for detaljeret beskrivelse

Rapport>begivenhedsrapport

Denne rapport giver statistik om forskellige begivenhedstyper, som er identificeret af den automatiske zzzPAT-analyse og af brugeren. En grafisk repræsentation giver en hurtig måde at se begivenhedsfordelingen på, mens oversigtssektionen giver statistisk information. Når det vises på skærmen, kan brugeren dobbeltklikke på et bestemt begivenhedsnavn (på den relevante række i diagrammet) for at få en detaljeret liste over alle begivenheder af denne type.
[bookmark: _Ref67056148][bookmark: _Toc534108096]Rapport>søvnindekser

Denne rapport giver en opsummering af studieresultatet, herunder pRDI, pAHI, ODI og Søvntid.
Rapport>patientopfølgningsrapport

Denne rapport giver mulighed for at sammenligne flere studier for samme patient. En grafisk repræsentation af pRDI, pAHI og ODI for de forskellige studier giver en hurtig måde at bestemme en tendens gennem studierne.
Søvn i % over den definerede grænseværdi for snorken dB vil også blive vist. 

Rapport > patientrapport

Denne rapport er udformet i form af et brev adresseret til patienten, der informerer patienten om testresultaterne for søvnstudiet. Den giver følgende patientdetaljer:
· Total søvntid
· Apnø/Hypopnø indeks (AHI)
· Respiratorisk forstyrrelsesindeks (RDI)
· Desaturationsindeks (ODI)
· Hurtig øjenbevægelse (REM)
Den sammenligner også disse med de normale gennemsnitlige indekser.


	[bookmark: _Hlk97757100][image: clip_image002]
	Bemærk

	
	zzzPAT-installationen installerer 3 patientletter.ini-filer: en for mand, en for kvinde, og den standard, der bruges i øjeblikket. Hvis patientens køn er defineret, vil den relevante skabelon blive vist, når patientrapporten produceres på et sprog, der har grammatisk køn; men hvis patientens køn ikke er defineret, vil den "mandlige" skabelon blive vist.




For at producere rapporten for patienten:
1. I menuen Rapport vælges Patientrapport.
2. Print denne rapport ved at klikke på Printer-ikonet

[bookmark: _Ref96585667][bookmark: _Hlk97757151]Rapport > Detaljeret rapport

[bookmark: _Hlk97757231]Denne rapports første side er den samme som første side i søvnrapporten. Resten af ​​rapportens sider præsenterer grafiske visninger af vejrtrækningsbegivenheder, snorken og kropspositionsdiagram (hvis der blev brugt en snorke-/kropspositionssensor), Iltmætning, puls, PAT-amplitude, Vågen/let søvn/dyb søvn og REM-stadier. Hver side repræsenterer en times søvntid.

[bookmark: _Hlk97757352]Rapport > Sammenfattende rapport for flere nætter

Denne sammenfattende rapport præsenterer statistikker over flere nætters søvn. Den er kun aktiveret, hvis den aktuelt åbnede undersøgelse indeholder WatchPAT™ ONE-data om flere nætter (se afsnittet 4.1.2.2 vedrørende forberedelse af en ny WatchPAT™ ONE-undersøgelse med mulighed for flere nætter valgt). Rapporten indeholder op til 3 undersøgelser (en undersøgelse pr. kolonne), hver med de samme WatchPAT™ ONE-enhedsoplysninger og patientstatistikoplysninger. En kolonne med gennemsnit af undersøgelsernes værdier (se nedenfor) er også inkluderet
[bookmark: _Toc534108112][bookmark: _Toc513360313][bookmark: _Toc513360297][bookmark: _Toc534108097]Print

Studiesignalerne registreret af WatchPAT™ og zzzPAT-analysen kan udskrives af:
Enten klikkes der på printerikonet [image: Print Screen Icon] på værktøjslinjen eller ved at vælge Fil>Print.
Brugeren har et antal muligheder for at printe:
Udskrift af hele studiet
Udskrift af skærmen
Udskrift af specifikke sektioner defineret af et tidsrum
Udskrift af specifikke kanaler

[bookmark: _Toc75938739][bookmark: _Toc396387047][bookmark: _Ref6148213][bookmark: _Toc534108109][bookmark: _Toc513360310][bookmark: _Toc125360439]Eksport af data
Se udvidet og illustreret vejledning for detaljeret beskrivelse
[bookmark: _Toc23069150][bookmark: _Toc75938740][bookmark: _Toc396387056][bookmark: _Toc125360440][bookmark: _Ref6912350]Værktøjer
[bookmark: _Ref299442665][bookmark: _Toc396387061][bookmark: _Ref97006805]Se udvidet og illustreret vejledning for detaljeret beskrivelse

[bookmark: _Toc75938741][bookmark: _Toc396387065][bookmark: _Toc125360441]Database-hjælpeprogram
[bookmark: _Hlk101182353]Se udvidet og illustreret vejledning for detaljeret beskrivelse
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	Installation

	Problemer
	Mulige årsager
	Løsning

	zzzPAT-nstallation kan ikke køre.
	Autorun-funktionen i Windows er ikke aktiveret.
	Åben Min Computer>zzzPAT CD og dobbeltklik på 'Setup.exe'.

	
	Windows-versionen er ikke kompatibel med zzzPAT.

	Brug en PC med et passende operativsystem.

	
	Hardware-konfiguration under minimumskravet.
	Skal have mindst 128 MB RAM og en Pentium-processor for at zzzPAT- installationen kan køre.

	zzzPAT kan ikke genkende WatchPAT
(Kun WP200)
	
USB-drive skal redefineres.
	
Vælg opsætning-> "Vælg WatchPAT Drive".  Indsæt WatchPAT-enheden i USB-drivet.
Klik OK.
Meddelelsen "Systemet søger efter WatchPAT-enhed" skulle nu vises.
Til sidst bør der vises en liste med WP200-drevet.
Vælg WatchPAT-drev og klik OK.


	Under Windows XP kan brugeren ikke indlæse studier eller betjene ‘Database-hjælpeprogram’ funktioner, selvom korrekte zzzPAT-brugerrettigheder er anvendt.
	Brugeren har ikke skrivetilladelse til de drev, som disse programmer er placeret på. 
	Tjek brugerens skrivetilladelser pr. sektion og omdefiner efter behov. 


[bookmark: _Toc30911225][bookmark: _Toc396387171][bookmark: _Toc125360447]Tabel 1 - Fejlfinding, Installation


	[bookmark: _Toc30911226][bookmark: _Toc534108126]zzzPAT

	Problemer
	Mulige årsager
	Løsning

	Analyser>Genindlæs studie og analyser muligheden i zzzPAT-vinduet er frakoblet
	Brugeren har ikke tilladelse til at betjene denne funktion.
	zzzPAT-administratorer kan modificere en brugers udvidede rettigheder. 

	
	Utilstrækkelig ledig plads på harddisken
	Ledig plads på harddisken må ikke være mindre end 100 MB, prøv igen

	Kan ikke Indlæse studie (funktion er deaktiveret)
	Der er mindre end 200 MB ledig plads på harddisken
	Frigør nok diskplads til at overskride minimumskravet på 200 MB, og prøv igen

	zzzPAT starter ikke eller opfører sig uforudsigeligt
	Nogle zzzPAT-filer kan være beskadiget/overskrevet
	Afinstaller og geninstaller zzzPAT. 

	Den åbne fil kan ikke vise REM 
	Filen blev gemt med en ældre version af zzzPAT, der ikke havde REM-funktioner, eller REM kunne ikke beregnes på grund af begrænsningerne i algoritmen.
	Kør analysen ved at sælge Analyse>Genindlæs studie og analyser

	Kan ikke generere søvnrapport - Knappen til søvnrapport er nedtonet
	Mindre end 100 MB ledig plads
	Ledig plads på harddisken må ikke være mindre end 100 MB, prøv igen

	
	Intet studie er indlæst, eller studiet er ugyldigt
	Åben det ønskede studie. Hvis studiet er åbent, kan der være ugyldige data, og den kan derfor ikke bruges

	Bruger kan ikke logge på zzzPAT
	zzzPAT vil ikke åbne, hvis en anden session er åben af en anden bruger
	Sørg for, at ingen andre brugere har forladt en åben zzzPAT-session på PC'en. Hvis du ikke kan bekræfte dette, så genstart PC'en

	
	Bruger er ikke defineret i zzzPAT
	Definer bruger af zzzPAT-administrator

	Send rapport via e-mail mislykkedes
	Microsoft Outlook blev ikke defineret som standard mailklient.
	Definer Microsoft Outlook (eller Outlook Express) som standard mailklient

	Ændringer i begivenhedsnavne vises ikke på skærmen
	Begivenhedsnavne er gemt sammen med den gemte analyse. Ændringer bliver synlige, når analysen køres igen
	Kør analysen ved at sælge Analyse>Genindlæs studie og analyser

	Fejl ved udskrift
	Ikke-kompatible printer drivere
	En postscript printerdriver giver den mest pålidelige drift sammen med zzzPAT. Installer en passende postscript driver for den givne printer og prøv igen

	Efter at klikke på Nyt studie i zzzPAT, forsvinder dialogboksen, og zzzPAT fryser
	Utilsigtet dobbeltklik på Ny patient knappen kan få dialogboksen til at blive skjult i baggrunden
	Tryk Alt-Tab for at bringe dialogboksen tilbage til forgrunden

	"Aktiver mulighed for flere nætter" vises ikke i dialogboksen Nyt studie
	WP har en S/W-version lavere end 2.2182
	Opgrader WP S/W til den nyeste S/W (ring til Itamar Support for en opgradering)

	"Aktiver manipulationssikker testindstilling" vises ikke i dialogboksen Ny studie
	WP har en S/W-version lavere end 2.2182
	Opgrader WP S/W til den nyeste S/W (ring til Itamar Support for en opgradering)

	Ingen data om snorken og kropsposition er præsenteret 
	SBP-RESBP-sensor blev ikke forbundet til WP
	Sørg for at forbinde SBP til WP.
Sørg for kun at tilslutte RESBP til WP200U eller WatchPAT™ 300

	
	RESBP-sensor blev forbundet til WP200 i stedet for WP200U/ WatchPAT™ 300
	Sørg for kun at tilslutte RESBP til WP200U eller WatchPAT™ 300

	
	Integreret SW er ikke kompatibel
	RESBP til WP200U: Sørg for at benytte en integreret SW 3.3228 eller nyere

	Ingen data om Resp-bevægelse præsenteret
	RESBP-sensoren blev ikke forbundet til WP200U eller WatchPAT™ 300
	Sørg for kun at tilslutte RESBP til WP200U eller WatchPAT™ 300

	Ugyldig aflæsning af oximetri (oximeterværdier på 127 %)
	Signalmangel på grund af sensorfejl / aflæsning under bevægelse / dårlig pulserende signalstyrke
	Hvis den ugyldige aflæsning af oximetri gentages selv under hvileforhold, skal du skifte uPAT-sonde. Hvis fortsat ugyldigt ændres uPAT-kabel eller kontakt Itamar Medicals support.


	Advarselsbesked: 
Snorke-/kropspositionsdata vises måske ikke korrekt i studiet.
Følg betjeningsvejledningen for yderligere information
	1. valgmulighed:
Hvis der anvendes digital RESBP med en enhed, som ikke understøtter det digitale RESBP såsom WatchPAT™ 200U, registreres der intet gyldigt signal af sensoren og advarselsbesked vises. 


2. valgmulighed:
Midlertidig afbrydelse mellem brystsensor og WatchPAT™-enheden identificeres i løbet af studiet
	1. valgmulighed:
Identifikation af digital vs analog RESBP-sensor (digital RESBP er ikke hvidmalet)

	Analog RESBP
	Digital RESBP

	[image: Analog RESBP
Logo

Description automatically generated with low confidence]
	[image: A picture containing text

Description automatically generated]


Sørg for digital RESBP kun anvendes med WatchPAT™ 300s.

2. valgmulighed:

· Kontroller brystsensoren er korrekt tilsluttet WatchPAT™-enheden. 
· Kontroller brystsensorkabel eller konnektor ikke er fysisk beskadiget.
· Kontroller snorke-/kropspositiondiagrammet indeholder data.
· Kontroller kropsposition ikke indeholder Na-værdier efter de første 10 minutter.
· Kontroller snorkeværdierne ikke er høje i det meste af studiet. 
Efter behov kontaktes Medical-support


[bookmark: _Toc396387172][bookmark: _Toc125360448]Tabel 2 - Fejlfinding, zzzPAT
	Delt adgang zzzPAT

	Problemer
	Mulige årsager
	Løsning

	Bruger kan ikke logge på zzzPAT
	I tilstanden Delt adgang kan brugeren være defineret i den delte database og ikke i den lokale eller omvendt
	Definer brugeren i den anden database, eller
Afslut zzzPAT, og log på den anden zzzPAT-database (enten lokal eller delt)

	Kan ikke finde den gemte fil
	Fil gemt i den anden database (enten den lokale eller delte database)
	· Bekræft, hvilken database zzzPAT er forbundet til (databaseforbindelsen vises i zzzPAT-statuslinjen)
· Afslut zzzPAT
· Start zzzPAT og vælg den anden database for at forbinde til den
· Vælg Fil>Åben og søg efter den ønskede fil

	Den delte database er ikke tilgængelig
	Netværk er frakoblet
	· Sørg for, at zzzPAT-stationen er korrekt forbundet til netværket, og at netværkstjenesten er tilgængelige for den. Konsulter med din systemadministrator, hvis nødvendigt

	Kan ikke åbne det valgte studie
	Studie bliver benyttet af en anden zzzPAT-bruger
	· Vent indtil den anden bruger lukker studiet og prøv igen


[bookmark: _Toc396387173][bookmark: _Toc125360449]Tabel 3 - Fejlfinding, Delt Adgang for zzzPAT


	Hjælpeprogrammer

	Problemer
	Mulige årsager
	Løsning

	Forberedelse af et nyt stude fejlede
	Enheden blev afbrudt fra USB-forbindelsen for tidligt.
	Fjern ikke enheden, før en besked om, at dialogboksen er gemt med succes vises

	Kun WP200(U): Nyt studie eller zzzPAT genkender ikke WP200(U)
	Volumen navn er blevet fjernet
	Formater drev med enhedsnavnet "WP200" 

	Kun WatchPAT™ 300: Nyt studie eller zzzPAT genkender ikke WatchPAT™ 300
	FTDI-drivere blev ikke installeret korrekt
	Sørg for, at FT4222H-grænsefladerne A, B, C, D vises i afsnittet "Universal Serial Bus controllers" i Enhedshåndtering, når en WatchPAT™ 300 er tilsluttet en USB. Hvis disse interfaces ikke vises, kontaktes Itamar Medicals support

	Database-værktøjer knappen i ‘Database-hjælpeprogram’ vinduet eller værktøjer i zzzPAT er deaktiveret
	Brugeren har ikke tilladelse til at betjene denne funktion
	zzzPAT-administratorer kan modificere en brugers udvidede rettigheder

	Brugeradministration knappen i ‘Database-hjælpeprogram’ vinduet eller Værktøjer>Brugeradministration er deaktiveret
	Brugeren har ikke tilladelse til at betjene denne funktion
	zzzPAT-administratorer kan modificere en brugers udvidede rettigheder 

	Databaseværktøjer åbner ikke
	zzzPAT eller Nyt studie kører
	Luk zzzPAT eller Nyt studie og åben databaseværktøjer

	Superbruger har glemt sit kodeord
	-
	Kontakt Itamar Medicals repræsentant


[bookmark: _Toc30911227][bookmark: _Toc396387174][bookmark: _Toc125360450][bookmark: _Ref30908983]Tabel 4 - Fejlfinding, Værktøjer
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[bookmark: _Hlk527451659]Denne licensaftale repræsenterer den fuldstændige og eksklusive forståelse mellem dig og Itamar Medical. Dokumentet kan ses på 
https://www.itamar-medical.com/lmages/licensewp.pdf


Hvis du har spørgsmål vedrørende denne licensaftale, eller hvis du ønsker at kontakte Itamar Medical af en eller anden grund, bedes du skrive til: 

USA:
Itamar Medical Inc.
3290 Cumberland Club Drive, Suite 100
Atlanta, Georgia 30339, USA
Tlf.: 1 888 748 2627

Globalt:
Itamar Medical Ltd. 
9 Halamish Street, PO 3579
Caesarea 3088900, Israel
Tlf.: +972 4 617 7000








[bookmark: _Toc75938744][bookmark: _Toc396387073][bookmark: _Toc261876528][bookmark: _Toc125360444]Bilag B: Myndighedsrepræsentant
Itamar Medicals autoriserede myndighedsrepræsentant er:

[image: cid:image008.jpg@01C99FE5.E9650A10]Arazy Group GmbH 

The Squaire 12, Am Flughafen,
60549 Frankfurt am Main, Tyskland

[bookmark: _Toc75938745][bookmark: _Toc125360445][bookmark: _Ref244235447][bookmark: _Ref244235456][bookmark: _Ref244235572]
Bilag C: Aktivering af NAF-kanal (termisk luftstrømssensor)
zzzPAT understøtter præsentation af NAF-signal (Nasal Air Flow) i kanalvisningen, mens NAF-tilbehør bruges under undersøgelsen.

Aktivering af NAF-kanal
1. Åbn\indlæs en undersøgelse, der blev optaget med NAF-tilbehør tilsluttet
2. Definer kanaler i Montage under Vis
[image: ]
3. NAF- og NAF-filtrerede (NAF-kanal med filter, der reducerer støjen på signalet) vises på venstre liste (Alle kanaler)
Marker NAF-kanalen, klik på tilføj, og klik derefter på OK

[image: Graphical user interface, application, Word

Description automatically generated]
4. Gå til Opsætning, Brugerindstillinger, fanen Administrer montage. Klik på Gem som, og navngiv den nye montage med NAF-kanalen tilføjet 
[image: ]
5. Efter Gem føjes den nye montage til montagelisten.
6. Klik på Indstil som standard, og klik på OK
[image: ]
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A
Analyze>Reload study and analyze · 17
D
Database Tools · 31
Database Wizard · 10, 25, 26, 31
E
Edit>Copy · 15, 16
Event
Management · 17
Export
Export a report · 18
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File>Close Study · 15
File>Exit · 15
File>Load Study and Analyze · 14
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S
Setup>Directories · 9
Setup>Settings · 9
Status Bar · 16
U
User Administration · 31
V
View>All Night Window · 16
View>Channels · 16
View>Study Details · 15
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zzzPAT
Using · 10
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